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invoice lines and the Job Code for the master job on the invoice header. (Previously, all 
lines were set to the Job Code of the job that the invoice was generated from). 

Note:  The existing Allow invoicing of sub jobs from master jobs profile setting 
must be ticked to enable the Invoice Job with Sub Jobs option. 

A new Check for Alerts option is also available under the Invoice Job dropdown. 
Selecting this option checks all lines for errors that would prevent invoicing. 

 

A new Allow Invoice via Master Job option is available on the Details tabs of sub jobs. 
When this option is ticked, the job can be invoiced from the master job. 

 

This option can also be set for all sub jobs on the Sub Jobs tab of a master job: 

 

If this option is unticked for a sub job, it will not be possible to select the job for 
invoicing on the Invoicing of Sub Jobs from Master Job window. 

Job Costing Extra Field Events 

Event logic has been added to Extra Fields in EXO Job Costing. This functionality, which 
was previously available for Sales Orders and Opportunities, allows Extra Fields on job 
headers and lines to be populated automatically. 

Extra Fields on the job header can be configured to update their values when the 
company account number on the job is first specified or when it is changed; similarly, 
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Extra Fields on job quote lines or job transaction lines (timesheets, costs) can be 
configured to update whenever the stock code on the line is specified/changed. 
Setting up events on job Extra Fields means that it is possible for the Extra Fields set up 
on a company/stock item to flow through to the job. 

When setting up Extra Fields in EXO Business Config, if JOB_TRANSACTIONS, 
JOBCOST_HDR or JOBCOST_LINES is selected for the Table name, an Events tab 
becomes available: 

 

The Event Field Name field displays the field on the Job Details window that will 
trigger the Extra Field update. For Extra Fields on the job header, this is ACCNO; for 
Extra Fields on job quote and transaction lines, it is STOCKCODE. 

The Event SQL field contains the SQL statement that will be used to populate the Extra 
Field when the relevant Opportunity field is set or changed. The following parameters 
can be used to pass in details: 

Job Header Job Quote Line Job Transaction 

 :Accno 

 :Current_User 

 :Stockcode 

 :Current_User  

 :Stockcode 

 :Jobno 

 :MasterJobno 

 :Accno 

 :Current_User 

Note:  Extra Field events override default values—if a default value is specified for 
an Extra Field that is populated by events, it will be ignored. 

Extra Fields on the Details Tab 

Extra Fields in positions 1 – 5 are now displayed on the Details tab of the Job Details 
window: 
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Extra Fields in position 6 – 24 are displayed on the Extra Fields tab as in previous 
versions. When adding a new job, the Extra Fields on the Extra Fields tab can now be 
edited before saving the job. 
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Extra Fields on Direct Time/Material Entry 

Any Extra Field defined for the JOB_TRANSACTIONS table will now appear on the 
Direct Time Entry and Direct Material Entry windows: 

 

 

If event logic has been set up for Extra Fields on the JOB_TRANSACTIONS table (see 
page 24), these Extra Fields will auto-populate based on the event logic when 
displayed on the Direct Time Entry and Direct Material Entry windows. 

Foreign Currency Debtors 

Debtor accounts that use a foreign currency can now be used in EXO Job Costing if the 
Allow foreign currency debtors in Job Costing Company-level profile setting is 
enabled. 

Note:  This profile setting existed in previous versions as a hidden setting; it is 
now available as an “Occasionally Used” setting.  
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Changes to the Job Search Tab 

The following improvements have been made to the Search tab on the Job 
Management screen: 

 

1. The screen now remembers the statuses of the filter panels, so that when they 
are turned on or off using the View menu, they will remain on or off when the 
screen is closed and re-opened. If all filters are turned off, the filter area now 
disappears, giving more screen space for the search results. 

2. The search grid now includes columns for master job codes and ID numbers, so 
that related sub jobs can be grouped together and jobs can be searched for by 
their master job. 

3. The search grid now includes a Branch column, so that search results can be 
sorted by branch. 

Link between Job Transactions and Stock Transactions 

A new STOCK_TRANS_SEQ_IN fields has been added to the JOB_TRANSACTIONS table. 
If the job transaction is related to a stock transaction, e.g. a Purchase Order, this field 
contains the ID number of the stock transaction. This field can be used in reports to 
provide a link between job and stock transactions. 

Hiding the Resource Planning Tab 

The Resource Planning tab (which displays all resource allocations in the system in the 
form of a Gantt chart) can now be removed from the Job Management and Setup Job 
Resource Allocation windows by enabling the new Hide Resource Planning Gantt Form 
User-level profile setting. 

1 

2 3 
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Job Costing Dashboard Tabs 

The Analysis tab on the Job Details window in MYOB EXO Job Costing is now a 
Dashboard interface, containing the following widgets: 

 Job Invoice Summary 

 Job Summary 

 Job Including Sub-Jobs 

 Job Snapshot 

 Current Job Alerts 

 

These widgets are based on Clarity reports, and can be customised to suit your needs. 

A second Dashboard tab has been added to the Job Details window. This Dashboard is 
blank by default, and can be customised with whatever widgets you require. 

Both new Dashboards accept the following input parameters: 

  Current Job No 

  Current Master Job No 

The Hide tabs in Job management screen profile setting has been updated to allow 
the new Dashboard tabs to be hidden if necessary—the Dashboard tab is hidden by 
default. 
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Custom Filters 

New custom filtering options are available on the Quote/Budget, Timesheets, Costs 
and Invoice tabs of the Job Details window. To create and apply filters, click the new 
Filter dropdown button: 

 

Any filters that have already been defined are available in the dropdown. You can also 
select None to turn off filtering, or Maintain Filters to create and edit filters on the 
Maintain Filters window: 

 

To edit an existing filter, select it from the Filter dropdown. To create a new filter, click 
New. Filters are edited using the same interface that is currently available when 
creating Contact Lists and searching for Debtors in Advanced Search mode. Users can 
create one or more filtering conditions based on the fields for the relevant table 
(JOBCOST_HDR, JOBCOST_LINES or JOBCOST_TRANSACTIONS). 

Note:  Computed fields are not supported in custom filters. 

As users add filtering conditions, the resulting query is displayed at the bottom of the 
window. Users can tick the Manual filter option to edit this query manually; doing so 
disables the filter building controls. 



 

MYOB EXO Business 8.7 Release Notes Page 32 of 68 
Copyright 2013 MYOB Technology Pty Ltd. 

Click Save after editing a filter to save the changes and apply the filter immediately. 
The icon on the Filter dropdown changes from red to green to indicate that a filter is 
currently applied. You can also apply an existing filter by selecting it from the 
dropdown and clicking Select and Close. Filters are saved separately for each tab, e.g. 
filters set up on the Costs tab will not be available on any other tabs. 

Grid Column Extra Fields 

 In previous versions, “Grid Column” was an option in the Dialog type dropdown, which 
would make Extra Fields appear as standard edit columns in the Sales Order, Job and 
Opportunity grids. This release adds the ability to have other types of Extra Field, e.g. 
check boxes or dropdown lists as a grid column. 

When configuring Extra Fields in the MYOB EXO Configurator, a new Grid Column 
option has been added separately from the Dialog type dropdown, so that multiple 
dialog types can be used as a grid column Extra Field:  

 

For header tables, the Grid Column option is always unticked and for line tables it is 
always ticked. The only exception is the SALESORD_LINES table, where the option can 
be changed—if it is ticked, Extra Fields will appear in the grid; if it is not, they will 
appear in the line periscope. 
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When the Grid Column option is ticked, the following options are available in the 
Dialog type dropdown: 

 Standard Edit 

 Check Box 

 Drop-Down Edit 

 Drop-Down Selection 

 Drop-Down SQL Selection 

 Date Picker 

Grid column Extra Fields support the Read Only option. This means it is possible, for 
example, to create an Extra Field that cannot be edited when displayed in grids and is 
only populated by an Extra Field event. 

Extra Fields on the Sales Order Supply Grid 

Any Extra Fields added to the SALESORD_LINES table will now appear on both the 
Order Details grid and the Supply Details grid, provided the new Grid Column option is 
ticked. 

GL Codes on Debtor Invoices 
This release adds the ability to enter GL codes on Debtor Invoices in the core EXO 
Business module (but not EXO POS). When the new Enable GL code entry into the 
stock code field on a debtors invoice User-level profile setting is enabled, GL codes 
can be entered into the Stock Code column of the Invoice Entry window. 

Note:  This feature is enabled by default—if you want to restrict its use for some 
users, disable the setting for those users’ profiles. 

To enter a GL code, enter “@” followed by the code. You can also enter “@” by itself 
or “@” and a partial GL code, then press ENTER to search for a GL code. Once entered, 
lines containing GL codes are highlighted in green: 

 

This feature is compatible with the existing Enable display and override of GL code 
from stock item profile setting, which displays a GL Code column on the Debtor 
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Invoice window. In this case, the GL code entered in the Stock Code column is also 
displayed in the GL Code column. 

Note:  To ensure backward compatibility with existing custom reports and add-
ons, the “@” stock code must exist as a placeholder for a valid stock code. 
The DBUpdate process creates an “@” stockcode when updating the EXO 
Business database to 8.7 if one does not already exist (it always exists by 
default, but may have been removed). No other stock codes should contain 
an @ symbol—this can be enforced by configuring the Prohibited 
characters in stock codes Company-level profile setting. 

The Invoice.clf, EmailInvoice.clf and ViewInvoice.clf forms have been updated with 
new line-formatting logic to display GL code lines differently from Stock or Lookup 
lines. 

Note:  To take full advantage of this feature, it may be useful to modify 
customized invoice formats to format General Ledger code lines differently 
from stock lines based on the new database field DR_INVLINES.CODETYPE 
(GL Code lines have a CODETYPE of “G”). 

Improvements to GL Posting 
When right-clicking on the batch details displayed on the Post to GL Ledgers window, 
the View Pre Posted Transactions right-click option is now a sub-menu with two 
options: Selected Account or All Accounts: 

 

The Selected Account option behaves the same as the View Pre Posted Transactions 
option in previous versions, showing the pre-journals that will be posted for the 
account that was right-clicked on. The All Accounts option displays a consolidated view 
of all accounts in the grid: 
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In both cases, the Pre-Posted GL Transactions window now displays additional 
columns, showing more information about the batch. 

Business Alerts 
This release adds the ability to set up custom business rules and alerts that are 
triggered when one of the following transactions is saved: 

 Sales Order 

 Purchase Order 

 Creditor Invoice 

 Debtor Invoice 

 Opportunity Quote 

 Job Quote 

 Job Transaction 

 Direct Material Entry  

 Direct Time Entry 

Note:  Alerts on Debtor and Creditor Invoices are only triggered from Invoice 
Entry screens, e.g. the Creditor Invoice Entry screen or the Invoice Entry 
screen in EXO Job Costing. They are not triggered when creating the invoice 
from another screen, e.g. when creating a Debtor Invoice from a Sales 
Order. Similarly, creating an Opportunity by copying an existing one will 
not trigger alerts on Opportunities. 

Rules using custom conditions can be attached to each of these system events; when a 
rule’s conditions are met, a message can be displayed to the user and a notification 
email can optionally be sent to one or more addresses. 

Business Alerts are set up in the EXO Business Configurator at System > Event Log > 
Business Alerts: 
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The Rules tab displays all rules defined in the system for the selected event; 
alternatively you can tick the Show all box to display all rules for all events. A selection 
of example alerts is installed with the system. 

Rules are listed in order of priority, i.e. in the order that they will be applied. To change 
priorities, move rules up or down using the up and down arrow buttons. 

Double-click on a rule to edit it or click New to create a new rule for the selected event 
(the New button is disabled when the Show All box is ticked). When adding or editing 
a rule, the Details tab appears. The Options sub-tab displays the conditions that must 
be met for the rule to be activated. 
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The Run Against option determine whether the rule should be applied to all lines 
related to the record, or to the record header. 

The Rule Type option determines how the rule’s conditions (see page 38) will be 
applied. Choose from: 

 Record Condition – applies conditions against the record.  

 SQL Query – applies a SQL query to each line individually. 

Once the rule is saved, this property cannot be changed. 
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The Behaviour section specifies what should happen in the EXO Business interface 
when the rule is triggered: 

 Silent – no message is displayed to the user, although the fact that the rule was 
triggered is still logged (see “Business Alert Auditing” on page 42). 

 Warning – a warning message is displayed to the user with Yes and No options. 
The user can click Yes to proceed with the action or No to cancel. 

 Blocking – a message is displayed to the user indicating that the action cannot 
proceed. 

For “Warning” or “Blocking” rules, enter the message to display to the user in the 
section below. This message can contain the same parameters that are used to build 
rule conditions—see below. 

Rule Conditions 

The bottom section of the Details tab is where you enter the conditions that must be 
met to trigger the rule. 

Rules with the type “Record Condition” are entered in the form of a filter that can 
include the parameters detailed below. 

Rules with the type “SQL Query” are entered in the form of a SQL statement to run 
against the EXO Business database. The parameters below can also be used in SQL 
statements. 

Parameter Meaning 

General (available for all rules) 

@CURRENT_USER The ID number of the logged on user. 

@STAFFNAME The name of the logged on user. 

@NOW The current date and time. 

@TODAY The current date. 

@EXOLINK A formatted exo:// protocol hyperlink to the transaction, e.g. 
exo://saleorder(10001). Can be used in notification emails. 

Sales Orders  

@ACCNO The ID number of the Debtor account on the Sales Order. 

@ACCOUNTNAME The name of the Debtor account on the Sales Order. 

@ORDERNO The ID number of the Sales Order. 

@SALESNO The ID number of the salesperson on the Sales Order. 

@SUBTOTAL The Sub Total amount on the Sales Order. 

@TAXTOTAL The GST Total amount on the Sales Order. 



 

MYOB EXO Business 8.7 Release Notes Page 39 of 68 
Copyright 2013 MYOB Technology Pty Ltd. 

Parameter Meaning 

@TOTALDISC The total discount on the Sales Order. 

@UNDISCOUNTED The undiscounted total of the Sales Order. 

@H A specified field from the SALESORD_HDR table, e.g. @H.DUEDATE. 

@L A specified field from the SALESORD_LINES table, e.g. @L.STOCKCODE. 

Purchase Orders  

@PURCHORDNO The ID number of the Purchase Order. 

@ACCNO The ID number of the Creditor account on the Sales Order. 

@ACCOUNTNAME The name of the Creditor account on the Sales Order. 

@SALESPERSON   The ID number of the staff member in the Purchase Order’s Ordered by 
field. 

@H A specified field from the PURCHORD_HDR table, e.g. @H.ORDERDATE. 

@L A specified field from the PURCHORD_LINES table, e.g. @L.UNITPRICE. 

Creditor Invoices  

@SEQNO The ID number of the invoice. 

@ACCNO The ID number of the Creditor account on the invoice. 

@ACCOUNTNAME The name of the Creditor account on the invoice. 

@H A specified field from the CR_TRANS table, e.g. @H.TRANSDATE. 

@L A specified field from the CR_INVLINES table, e.g. @L.TAXRATE. 

Debtor Invoices  

@SEQNO The ID number of the invoice. 

@ACCNO The ID number of the Debtor account on the invoice. 

@ACCOUNTNAME The name of the Debtor account on the invoice. 

@H A specified field from the DR_TRANS table, e.g. @H.SUBTOTAL. 

@L A specified field from the DR_INVLINES table, e.g. @L.DISCOUNT. 

Jobs  

@ACCNO The ID number of the Debtor account on the job. 

@ACCOUNTNAME The name of the Debtor account on the job. 

@JOBNO The job number. 
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Parameter Meaning 

@H A specified field from the JOBCOST_HDR table, e.g. @H.STATUS. 

@F A specified field from the JOBCOST_FLAGS table, e.g. @F.ISACTIVE. 

@Q A specified field from the JOBCOST_LINES table, e.g. @Q.STOCKCODE. 

@T A specified field from the JOB_TRANSACTIONS table, e.g. @T.QUANTITY. 

Opportunities  

@ACCNO The ID number of the company account on the opportunity. 

@ACCOUNTNAME The name of the company account on the opportunity. 

@OPPORTUNITYID The ID number of the opportunity, or “New” if it has not been saved yet. 

@CONTACTID The ID number of the contact associated with the opportunity. 

@CONTACTNAME The name of the contact associated with the opportunity. 

@H A specified field from the OPPORTUNITY table, e.g. @H.PROBABILITY. 

@L A specified field from the OPPORTUNITY_QUOTE table, e.g. 
@L.QUANTITY. 

The alias parameters that give access to the fields of a table (@H, L@, etc.) can be used 
to access Extra Fields; however, computed fields are not supported in Business Alerts. 

Note:  While these parameters are not case-sensitive, the values of table fields 
are, e.g. @F.ISACTIVE would need to look for the value “Y”, not “y”. 

Rule Actions 

The Actions sub-tab defines a list of actions to perform when the rule is triggered. At 
present, the only available action is to send an email to specified recipients using the 
new EXO Email Service (see page 43). 
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All actions set up for the rule are displayed in the order that they will be applied. 
Actions can be re-ordered using the arrow buttons on the right. Click New to create a 
new action.  

 

On the Details sub-tab, enter a descriptive name for the action, then specify who to 
send the email to. One or more EXO Business staff members can be selected as 
recipients from the Internal Recipients dropdown, and other email addresses can be 
entered manually into the Other Recipients field.  

Enter a subject line and the message text to send/display. The message body can 
include any of the parameters that are available for the rule (see page 38). In 
particular, the @EXOLINK parameter can be used to insert a formatted exo:// protocol 
hyperlink to the relevant record into the email. 

Once all information has been entered, click Save Action to add the action to the rule. 

Note:  Clicking Save Action adds the action to the rule, but does not save the rule 
itself—click the Save button on the main toolbar to save the rule and all of 
its actions to the EXO Business database. Rules that have been added but 
not yet saved are listed on the Actions sub-tab with the ID “New”. 
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Applying Rules to Users 

The Apply to Staff sub-tab lets you specify which EXO Business staff members the rule 
applies to: 

 

Tick the boxes for the users that this rule applies to, or tick Apply To All Users. 

Business Alert Auditing 

 Every time a Business Alert is triggered, an entry is recorded in the REASON_EVENTS 
table. New Reason Classes are created automatically for each type of event that alerts 
can be created for. 

For alerts that send a message, an entry is also stored in the new EVENTS_SCHEDULE 
table. Entries include the values of all parameters relating to the rule. 

The Audit Report (ReasonReportbyClass.CLR) has been updated to include information 
on Business Alerts. 
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EXO API 
This version includes new configuration options to support the EXO API. The local 
components needed to access the EXO API from an EXO Business server can be 
installed and set up using the MYOB EXO Business Services Setup Wizard and the 
MYOB EXO Business Service Configuration utility (see “Installing EXO Business 
Services” on page 12).  

A new “EXO API” module can be added in the Company section of EXO Business Config; 
when this module is added and licensed, a new API Access tab appears when editing 
staff members: 

  

Ticking the Allow API Access box generates an API token for the staff member. You can 
right-click on the token to copy it to the clipboard. 

See the MYOB EXO API Release Notes document for more information on the EXO API. 

EXO Email Service 
This release adds an email service utility, ExoEmailService.exe, which can be used to 
automate the sending of emails from the EXO Business system. This service is used by 
the new Business Alerts (see page 35), but it can potentially be used to send emails for 
any reason. 

Installing the Service 

You can install and set up the EXO Email Service using the MYOB EXO Business Services 
Setup Wizard and the MYOB EXO Business Service Configuration utility (see “Installing 
EXO Business Services” on page 12).  

Run the MYOB EXO Business Services Setup Wizard, and when asked which features 
you want to install, make sure that the Messaging Service option is enabled. 

Once the wizard has completed, you are given the option of running the service 
configuration utility to set up the service. You can run the utility, 
MYOB.ED.EXO.Cloud.ServiceConfig.exe, at any time after installation. 

Note:  The service configuration utility must be run on the server that the EXO 
Email Service is installed on, using an account with administrator privileges. 
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The email service can also be set up manually: 

1. Copy the ExoEmailService.exe file to the main EXO Business install directory. 
2. Open a command prompt with administrative rights at this location. 
3. Enter ExoEmailService.exe /install [connection], where 

[connection] is the connection name for the instance of EXO Business that 
you are installing the service for. 

You can install the service for multiple instances of EXO Business by specifying multiple 
connection names, separated by spaces, e.g. 

ExoEmailService.exe /install Connection1 Connection2 

Once the service is installed, you can update the list of instances that it is installed for 
by entering: 

ExoEmailService.exe /config [list of connections] 

 This removes all current connections and adds only those connections you specify, i.e. 
if you want to add a connection, you must list the new connection and all existing 
ones. 

Note:  The EXO email service runs using the Local System account. This means 
that the EXO Business database connection must have been created while 
logged in as an administrator account; otherwise the service will not be 
able to find the connection details. If you receive the error “Failed to start 
service”, you may need to open the EXO Business Connection Editor 
window while logged in as an administrator, then delete and re-create the 
connection. 
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Configuring the Service 

Once the service has been installed, you can configure it in the EXO Business 
Configurator at System > Email Service. Two configuration screens are available. The 
first, Email Service Configuration, lets you configure the details of the email server, 
including address, authentication and default user information: 
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The second configuration screen, Email Time Configuration, lets you specify when the 
email service should and shouldn’t send emails, and the how often it should check for 
new emails to send: 

 

Both configuration screens have controls that let you stop and start the email service. 

Once the EXO Email Service is running, it scans the EVENT_EMAILS table for unsent 
email messages, and attempts to send all messages that it finds. If an email fails to 
send, the service will attempt to send it again the next time it checks for emails. 

Note:  More detailed information on installing, configuring and using the EXO 
Email Service are available in the EXO Email Service white paper, available 
on the new EXO Business Education Centre (see page 47). 

  




